MATRIX FACTORIZATION




Build a movie recommender using matrix
factorization with ML.NET

https://docs.microsoft.com/en-us/dotnet/machine-learning/tutorials/movie-recommendation

This tutorial shows you how to build a movie recommender with MLNET ina .NET Core
console application. The steps use C# and Visual Studio 2019.

In this tutorial, you learn how to:

e Select a machine learning algorithm
e Prepare and load your data

e Build and train a model

e FEvaluate a model

e Deploy and consume a model

Prerequisites

Visual Studio 2019 or later or Visual Studio 2017 version 15.6 or later with the ".NET Core cross-
platform development” workload installed.

Select the appropriate machine learning task

There are several ways to approach recommendation problems, such as recommending a list
of movies or recommending a list of related products, but in this case you will predict what
rating (1-5) a user will give to a particular movie and recommend that movie if it's higher than a
defined threshold (the higher the rating, the higher the likelihood of a user liking a particular
maovie).


https://docs.microsoft.com/en-us/dotnet/machine-learning/tutorials/movie-recommendation

Create a console application

1. Open Visual Studio 2017. Select File > New > Project from the menu bar. In the New
Project dialog, select the Visual C# node followed by the NET Core node. Then select
the Console App (NET Core) project template. In the Name text box, type
"MovieRecommender” and then select the OK button.

2. Create a directory named Data in your project to store the data set:

3. In Solution Explorer, right-click the project and select Add > New Folder. Type "Data’
and hit Enter.

4. Install the Microsoft. ML and Microsoft. ML.Recommender NuGet Packages:

a. In Solution Explorer, right-click the project and select Manage NuGet Packages.
Choose "nuget.org” as the Package source, select the Browse tab, search for
Microsoft ML, select the package in the list, and select the Install button. Select
the OK button on the Preview Changes dialog and then select the | Accept
button on the License Acceptance dialog if you agree with the license terms for
the packages listed. Repeat these steps for Microsoft ML.Recommender.

5. Add the following using statements at the top of your Program.cs file:

using System;

using System.IO;

using Microsoft.ML;

using Microsoft.ML.Trainers;

Download your data

1. Download the two datasets and save them to the Data folder you previously created:
e Right click on recommendation-ratings-train.csv and select "Save Link (or Target)
As "
e Right click on recommendation-ratings-test.csv and select "Save Link (or Target)
As..”

Make sure you either save the *.csv files to the Data folder, or after you save it
elsewhere, move the * csv files to the Data folder.

2. In Solution Explorer, right-click each of the *.csv files and select Properties. Change the
value of Copy to Output Directory to Copy if newer.


https://raw.githubusercontent.com/dotnet/machinelearning-samples/main/samples/csharp/getting-started/MatrixFactorization_MovieRecommendation/Data/recommendation-ratings-train.csv
https://raw.githubusercontent.com/dotnet/machinelearning-samples/main/samples/csharp/getting-started/MatrixFactorization_MovieRecommendation/Data/recommendation-ratings-test.csv

Load your data

The first step in the ML.INET process is to prepare and load your model training and testing data.

The recommendation ratings data is split into Train and Test datasets. The Train data is used to
fit your model. The Test data is used to make predictions with your trained model and evaluate
model performance. It's common to have an 80/20 split with Train and Test data.

Below is a preview of the data from your *.csv files:

userld movield rating timestamp
1 1 4 964982703
1 3 4 964981247
1 6 4 964982224
1 47 5 964983815
1 50 5 964982931
1 70 3 964982400
1 101 5 964980868
1 110 4 964982176
1 151 5 964984041

In the *.csv files, there are four columns:

e userld
e movield
e rating

e timestamp

In machine learning, the columns that are used to make a prediction are called Features, and
the column with the returned prediction is called the Label.

You want to predict movie ratings, so the rating column is the Label. The other three columns,
userld, movield, and timestamp are all Features used to predict the Label.

Features Label
userId rating
movield

timestamp

It's up to you to decide which Features are used to predict the Label You can also use methods
like permutation feature importance to help with selecting the best Features.

In this case, you should eliminate the timestamp column as a Feature because the timestamp
does not really affect how a user rates a given movie and thus would not contribute to making
a more accurate prediction:



Features Label
userld rating

movield

Next you must define your data structure for the input class.
Add a new class to your project:

1. In Solution Explorer, right-click the project, and then select Add > New ltem.
2. Inthe Add New ltem dialog box, select Class and change the Name field to
MovieRatingData.cs. Then, select the Add button.

The MovieRatingData.cs file opens in the code editor. Add the following using statement to the
top of MovieRatingData.cs:

using Microsoft.ML.Data;

Create a class called MovieRating by removing the existing class definition and adding the
following code in MovieRatingData.cs:

public class MovieRating

{
[LoadColumn(9)]

public float userId;
[LoadColumn(1)]
public float movield;
[LoadColumn(2)]
public float Label;

MovieRating specifies an input data class. The LoadColumn attribute specifies which columns
(by column index) in the dataset should be loaded. The userld and movield columns are your
Features (the inputs you will give the model to predict the Label), and the rating column is the
Label that you will predict (the output of the model).

Create another class, MovieRatingPrediction, to represent predicted results by adding the
following code after the MovieRating class in MovieRatingData.cs:

public class MovieRatingPrediction

{
public float Label;

public float Score;



In Program.cs, replace the Console WriteLine("Hello World!") with the following code inside
Main():

MLContext mlContext = new MLContext();

The MLContext class is a starting point for all ML.NET operations, and initializing mlContext
creates a new ML.NET environment that can be shared across the model creation workflow
objects. It's similar, conceptually, to DBContext in Entity Framework.

After Main(), create a method called LoadData():

public static (IDataView training, IDataView test) LoadData(MLContext mlContext)

{
¥

Initialize your data path variables, load the data from the *.csv files, and return the Train and
Test data as IDataView objects by adding the following as the next line of code in LoadDatal):

var trainingDataPath = Path.Combine(Environment.CurrentDirectory, "Data",
"recommendation-ratings-train.csv");

var testDataPath = Path.Combine(Environment.CurrentDirectory, "Data",
"recommendation-ratings-test.csv");

IDataView trainingDataView =
mlContext.Data.LoadFromTextFile<MovieRating>(trainingDataPath, hasHeader: true,
separatorChar: ',');

IDataView testDataView = mlContext.Data.LoadFromTextFile<MovieRating>(testDataPath,
hasHeader: true, separatorChar: ',');

return (trainingDataView, testDataView);

Data in ML.NET is represented as an IDataView interface. IDataView is a flexible, efficient way of
describing tabular data (numeric and text). Data can be loaded from a text file or in real time
(for example, SQL database or log files) to an IDataView object.

The LoadFromTextFile() defines the data schema and reads in the file. It takes in the data path
variables and returns an IDataView. In this case, you provide the path for your Test and Train
files and indicate both the text file header (so it can use the column names properly) and the
comma character data separator (the default separator is a tab).

Add the following code in the Main() method to call your LoadData() method and return the
Train and Test data:

(IDataView trainingDataView, IDataView testDataView) = LoadData(mlContext);



Build and train your model

Create the BuildAndTrainModel() method, just after the LoadData() method, using the following
code:

public static ITransformer BuildAndTrainModel(MLContext mlContext, IDataView
trainingDataView)

{
}

Define the data transformations by adding the following code to BuildAndTrainModel():

IEstimator<ITransformer> estimator =
mlContext.Transforms.Conversion.MapValueToKey(outputColumnName: "userIdEncoded",
inputColumnName: "userId")

.Append(mlContext.Transforms.Conversion.MapValueToKey(outputColumnName:
"movieIdEncoded", inputColumnName: "movieId"));

Since userld and movield represent users and movie titles, not real values, you use the
MapValueToKey() method to transform each userld and each movield into a numeric key type
Feature column (a format accepted by recommendation algorithms) and add them as new
dataset columns:

userld movield Label userldEncoded movieldEncoded
1 1 4 userkey maoviekey
1 3 4 userkey moviekey2
1 & 4 userkey maoviekeys

Choose the machine learning algorithm and append it to the data transformation definitions by
adding the following as the next line of code in BuildAndTrainModel():

var options = new MatrixFactorizationTrainer.Options

{
MatrixColumnIndexColumnName = "userIdEncoded",
MatrixRowIndexColumnName = "movieIdEncoded",
LabelColumnName = "Label",
NumberOfIterations = 20,
ApproximationRank = 100

s

var trainerEstimator =
estimator.Append(mlContext.Recommendation().Trainers.MatrixFactorization(options));



The MatrixFactorizationTrainer is your recommendation training algorithm. Matrix Factorization
is a common approach to recommendation when you have data on how users have rated
products in the past, which is the case for the datasets in this tutorial. There are other
recommendation algorithms for when you have different data available (see the Other
recommendation algorithms section below to learn more).

In this case, the Matrix Factorization algorithm uses a method called "collaborative filtering”,
which assumes that if User 1 has the same opinion as User 2 on a certain issue, then User 1is
more likely to feel the same way as User 2 about a different issue.

For instance, if User 1 and User 2 rate movies similarly, then User 2 is more likely to enjoy a
movie that User 1 has watched and rated highly:

Incredibles 2 (20818) The Avengers (2812) Guardians of the Galaxy (2014)
User Watched and liked Watched and liked Watched and liked movie
1 movie maovie
User Watched and liked Watched and liked Has not watched -- RECOMMEND
2 movie maovie movie

The Matrix Factorization trainer has several Options, which you can read more about in the
Algorithm hyperparameters section below.

Fit the model to the Train data and return the trained model by adding the following as the next
line of code in the BuildAndTrainModel() method:

Console.WriteLine("=============== Training the model ===============");
ITransformer model = trainerEstimator.Fit(trainingDataView);

return model;

The Fit() method trains your model with the provided training dataset. Technically, it executes
the Estimator definitions by transforming the data and applying the training, and it returns back
the trained model, which is a Transformer.

Add the following as the next line of code in the Main() method to call your
BuildAndTrainModel() method and return the trained model:

ITransformer model = BuildAndTrainModel(mlContext, trainingDataView);



Evaluate your model

Once you have trained your model, use your test data to evaluate how your model is
performing.

Create the EvaluateModel() method, just after the BuildAndTrainModel() method, using the
following code:

public static void EvaluateModel(MLContext mlContext, IDataView testDataView,
ITransformer model)

{
¥

Transform the Test data by adding the following code to EvaluateModel():

Console.WriteLine("=============== Evaluating the model ===============");
var prediction = model.Transform(testDataView);

The Transform() method makes predictions for multiple provided input rows of a test dataset.

Evaluate the model by adding the following as the next line of code in the EvaluateModel()
method:

var metrics = mlContext.Regression.Evaluate(prediction, labelColumnName: "Label",
scoreColumnName: "Score");

Once you have the prediction set, the Evaluate() method assesses the model, which compares
the predicted values with the actual Labels in the test dataset and returns metrics on how the
model is performing.

Print your evaluation metrics to the console by adding the following as the next line of code in
the EvaluateModel() method:

Console.WriteLine("Root Mean Squared Error : +

metrics.RootMeanSquaredError.ToString());
Console.WriteLine("RSquared: " + metrics.RSquared.ToString());

Add the following as the next line of code in the Main() method to call your EvaluateModel()
method:

EvaluateModel(mlContext, testDataView, model);



The output so far should look similar to the following text:

Console ™ Copy

=============== Tpaining the model ===============

iter tr_rmse obj
e 1.54832 3.1262e+85
1 8.9221 1.56038e+85
2 8.8687 1.5846e+85
3 8.8416 1.4584,485
4 2.8142 1.4289e+85
5 8.7849 1.3987e+85
+] 8.7544 1.3594e+85
7 8.7266 1.3361e+@5
] 8.6987 1.3118e+85
9 ©.6751  1.2948e+@5
18 8.6538 1.2766e+85
11 @.6358  1.2p44e485
12 8.6197 1.2541e+85
13 8.6067  1.2476e405
14 8.5953 1.2382e+85
15 ©8.5871  1.2342e485
16 8.5781 1.2279%e+85
17 8.5713 1.2248e+85
18 8.5668 1.2238e+85
19 8.5592 1.2179e+85

=============== Evaluating the model ===============
Rms: @.994851469738769
RSquared: ©.412556293844873

In this output, there are 20 iterations. In each iteration, the measure of error decreases and
converges closer and closer to 0.

The root of mean squared error (RMS or RMSE) is used to measure the differences between the
model predicted values and the test dataset observed values. Technically it's the square root of
the average of the squares of the errors. The lower it is, the better the model is.

R Squared indicates how well data fits a model. Ranges from 0 to 1. A value of O means that the
data is random or otherwise can't be fit to the model A value of 1 means that the model exactly
matches the data. You want your R Squared score to be as close to 1 as possible.



Use your model

Now you can use your trained model to make predictions on new data.

Create the UseModelForSinglePrediction() method, just after the EvaluateModel() method, using
the following code:

public static void UseModelForSinglePrediction(MLContext mlContext, ITransformer
model)
{

}

Use the PredictionEngine to predict the rating by adding the following code to
UseModelForSinglePrediction():

Console.WriteLine("=============== Making a prediction ===============");
var predictionEngine = mlContext.Model.CreatePredictionEngine<MovieRating,
MovieRatingPrediction>(model);

Create an instance of MovieRating called testinput and pass it to the Prediction Engine by
adding the following as the next lines of code in the UseModelForSinglePrediction() method:

var testInput = new MovieRating { userId = 6, movield = 10 };

var movieRatingPrediction = predictionEngine.Predict(testInput);

The Predict() function makes a prediction on a single column of data.

You can then use the Score, or the predicted rating, to determine whether you want to
recommend the movie with movield 10 to user 6. The higher the Score, the higher the
likelinood of a user liking a particular movie. In this case, let's say that you recommend movies
with a predicted rating of > 3.5.

To print the results, add the following as the next lines of code in the
UseModelForSinglePrediction() method:

if (Math.Round(movieRatingPrediction.Score, 1) > 3.5)

{
Console.WriteLine("Movie
user " + testInput.userld);

}

else

{
Console.WriteLine("Movie
+ testInput.userId);

}

+ testInput.movield + is recommended for

+ testInput.movield + is not recommended

for user



Add the following as the next line of code in the Main() method to call your
UseModelForSinglePrediction() method:

UseModelForSinglePrediction(mlContext, model);

The output of this method should look similar to the following text:

Console ™ Copy

Movie 18 is recommended for user 6

Save your model

To use your model to make predictions in end-user applications, you must first save the model.

Create the SaveModel() method, just after the UseModelForSinglePrediction() method, using
the following code:

public static void SaveModel(MLContext mlContext, DataViewSchema
trainingDataViewSchema, ITransformer model)

{
¥

Save your trained model by adding the following code in the SaveModel() method:

var modelPath = Path.Combine(Environment.CurrentDirectory, "Data",
"MovieRecommenderModel.zip");

Console.WriteLine("=============== Saving the model to a file ===============");
mlContext.Model.Save(model, trainingDataViewSchema, modelPath);

This method saves your trained model to a .zip file (in the "Data” folder), which can then be
used in other NET applications to make predictions.

Add the following as the next line of code in the Main() method to call your SaveModel()
method:

SaveModel(mlContext, trainingDataView.Schema, model);



Use your saved model

Once you have saved your trained model, you can consume the model in different
environments.

Results

After following the steps above, run your console app (Ctrl + F5). Your results from the single
prediction above should be similar to the following. You may see warnings or processing
messages, but these messages have been removed from the following results for clarity.

Console ™ copy

=============== Tr'a]'_ning the model ===============

iter tr_rmse obj
(] 1.5382 3.1213e+085
1 8.9223 1.6851e+05
2 8.8691 1.5858e+05
3 8.8413 1.4576e+05
4 8.8145 1.4282e+05
5 8.7848 1.3895e+05
6 8.7552 1.3613e+05
7 @.7259 1.3357e+85
8 8.6987 1.3121e+85
9 8.6747 1.294%9e+65
1@ 8.6533 1.2766e+05
11 8.6353 1.2636e+05
12 6.6209 1.2561e+05
13 8.60872 1.2462e+05
14 8.5965 1.2394e+85
15 8.5868 1.2352e+05
16 8.5782 1.2279e+05
17 8.5713 1.2227e+085
18 8.5637 1.2198e+05
19 8.56084 1.2178e+05

=============== Evaluating the model ===============

Rms: 8.977175877487166

RSquared: @.43233349213192

=============== Making a prediction ===============

Movie 18 is recommended for user 6

=============== Saving the model to a file ===============

Congratulations! You've now successfully built a machine learning model for recommending
movies. You can find the source code for this tutorial at the dotnet/samples repository.



https://github.com/dotnet/samples/tree/main/machine-learning/tutorials/MovieRecommendation

